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Course contents

• Overview: Get control of your e-mail

• Lesson 1: Why move e-mail?

• Lesson 2: AutoArchive is effortless

• Lesson 3: Get personal with Personal Folders

Each lesson includes a list of suggested tasks and a set of 
test questions.
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Do you get messages from your 
system administrator telling you that 
you’re keeping too much e-mail on the 
server? Are you perplexed every time 
Outlook tells you it’s ready to archive 
your e-mail? Are you mystified by 
Personal Folders?

Overview: Get control of your e-mail

If you answered “yes” to any of these, 
you’ll be glad to know that filing and 
archiving your e-mail can help you 
regain control. 
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Course goals

• Stop storing so much stuff on the server. Instead, move it 
to Outlook personal storage files called PSTs that you 
keep on your own computer. 

• Choose whether to move e-mail to Archive Folders or to 
Personal Folders, and whether to move it automatically or 
manually. 

• Customize folder names and settings to meet your 
personal needs and preferences. 



Lesson 1

Why move e-mail?
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Why move e-mail? 

Space isn’t infinite, at least not on 
your e-mail system’s computer. 
Sooner or later, you’ll want to know 
how you can create personal 
storage files for your e-mail 
messages. 

You can store these files locally on 
your own computer in a personal 
storage, or PST, file. Then you 
won’t be restricted to size 
limitations set by someone else.

Two routes to a PST file: 
personal folders and 
archiving
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What you gain

It may seem as if your e-mail is 
already on your computer. But if you 
use a Microsoft Exchange server or 
an Internet e-mail service, most of 
your e-mail lives on an e-mail server 
until you move it.

But move it where? Outlook lets you 
create local data files, called 
personal stores (PST files), that 
really are on your own computer. 

Four big benefits to 
storing in a PST
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What you gain

By using Outlook PST files, you gain 
many freedoms:

Four big benefits to 
storing in a PST file

Freedom from nagging. If you 
keep everything in the Inbox, and 
the Inbox resides on a server, you’re 
going to get a message someday 
saying it’s time to clean up your act. 
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What you gain

By using Outlook PST files, you gain 
many freedoms:

Four big benefits to 
storing in a PST file

Freedom from clutter. With most 
messages stored in a separate 
location, you can concentrate on the 
ones you really need to keep handy.

Freedom from bulkiness. PST 
files can be compressed, making 
them an efficient way to store 
messages. 
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What you gain

By using Outlook PST files, you gain 
many freedoms:

Four big benefits to 
storing in a PST file

Freedom of movement. PST files 
are portable: You can move them 
from one computer to another, and 
you can easily store them on a CD. 
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In or out of your Mailbox?

When you receive messages, they’re 
sent to the Inbox. Typically, the 
Inbox is stored inside the Mailbox, 
along with Calendar, Contacts, and 
other folders. 

When you store messages locally, 
you send them to Archive Folders or 
to Personal Folders, separate data 
files that are outside the Mailbox. 

1. Mailbox

2. Archive Folders and 
Personal Folders
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Two roads, one computer

What’s the difference between 
Archive Folders and Personal 
Folders? The next lessons will 
explain it all and help you choose 
which one to use. 

And no one says you have to use 
only one sort of folder or the other. 
You can use both if you want to!

Two routes to storing 
messages in a PST file
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Two roads, one computer

It’s wise to keep these points in 
mind from the start: 

Two routes to storing 
messages in a PST file

1. Messages stored in PST files are 
not accessible from your e-mail 
server. They’re on your own 
computer, and if you go to 
another computer, you can’t read 
them unless you take them along 
yourself.
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Two roads, one computer

It’s wise to keep these points in 
mind from the start: 

Two routes to storing 
messages in a PST file

2. Only one person at a time can 
open a PST file. Even if you share 
your computer and share 
permission to access a PST file, 
each user must close it before 
another user can open it.
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Test 1, question 1

To reduce the size of the Mailbox, which of these 
could you store messages in? (Pick one answer.)

1. Personal Folders or Archive Folders. 

2. A new folder inside the Inbox. 

3. A shoebox under your bed. 
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Test 1, question 1: Answer

Personal Folders or Archive Folders

Either type of folder will work, and the rest of the 
presentation will describe which one to choose depending 
on your goal.  
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Test 1, question 2

What does PST stand for? (Pick one answer.)

1. Personal Sorting File 

2. Personal Store 

3. Particularly Stupid Test 
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Test 1, question 2: Answer

Personal Store

You personally store PST files on your own computer. 
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Test 1, question 3

You’ve decided to move some e-mail to a PST 
file. Which of the following should you keep in 
mind? (Pick one answer.)

1. If you set up archiving, you’re stuck with archiving 
for life. 

2. Once your e-mail is moved to a PST file, you can’t 
access it from the server. 

3. AutoArchive is a lazy choice. 
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Test 1, question 3: Answer

Once your e-mail is moved to a PST file, you can’t access it 
from the server.

It’s on your computer, and the server can’t find it.



Lesson 2

AutoArchive is effortless
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AutoArchive is effortless

Do you have guilty feelings when 
you click No in this dialog box 
because you’re not really sure what 
AutoArchive does? 

With a little help on the details, you 
may learn to love AutoArchive. On 
the other hand, you may find that 
you prefer to archive manually or to 
use Personal Folders files. Then you 
can feel good about saying No.

Is this message familiar?
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It’s automatic

Maybe this sounds like you:

Archive Folders and 
archived messages

• You never move or delete e-mail 
messages. 

• You may add folders to the Inbox, 
but you don’t change their names 
or remove them. Once and for 
good, is your filing motto.

If so, then AutoArchive is for you.
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It’s automatic

AutoArchive creates its own rules 
that work behind the scenes (you 
don’t have to bother creating them). 
In that process, it creates a folder 
called Archive Folders.  

Archive Folders and 
archived messages

1. Subfolders in Archive Folders are 
exactly the same as subfolders in 
Mailbox. Wherever you were used 
to looking for your messages, the 
archive looks the same way. 
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It’s automatic

AutoArchive creates its own rules 
that work behind the scenes (you 
don’t have to bother creating them). 
In that process, it creates a folder 
called Archive Folders.  

Archive Folders and 
archived messages

2. Archived messages are removed 
from Mailbox and placed in the 
equivalent subfolders in Archive 
Folders.
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Is it on? 

You can tell if Outlook is set up to 
use AutoArchive by opening the 
AutoArchive dialog box: Click 
Options on the Tools menu, click 
the Other tab, and then click 
AutoArchive.

By default, AutoArchive is set to run 
every 14 days. To change the 
frequency, change the number in 
the days box.

The Run AutoArchive 
every check box in the 
AutoArchive dialog box
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Is it on? 

Of course, you’ll also know that 
AutoArchive is running if you see the 
friendly dialog box we showed you 
at the beginning of this lesson.

The Run AutoArchive 
every check box in the 
AutoArchive dialog box

If you’d rather not see that dialog 
box each time AutoArchive runs, 
clear the Prompt before 
AutoArchive runs check box 
(shown in the illustration).
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You do it your way

If you’d like to customize your 
archiving, Outlook makes it easy to 
take control. 

You can archive different folders at 
different rates—or not at all. Or you 
can empty specified folders without 
archiving their contents.

Different archiving for 
different folders
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You do it your way

Use the Properties dialog box to 
specify different archiving for 
different folders: 

Different archiving for 
different folders

1. Right-click the folder.

2. Click Properties on the shortcut 
menu.
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You do it your way

Use the Properties dialog box to 
specify different archiving for 
different folders: 

Different archiving for 
different folders

3. In the Properties dialog box for 
the folder, click the AutoArchive
tab and specify archive settings. 
(In this case, the folder name is 
"For Action," so the dialog box is 
called For Action Properties.)
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Choose your settings

To customize archive settings for a 
folder, right-click the folder, click 
Properties, and then click the 
AutoArchive tab. 

AutoArchive tab of the 
Properties dialog box 
for a folder
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Choose your settings

Next, as the picture shows: 

AutoArchive tab of the 
Properties dialog box 
for a folder

1. Click Archive this folder using 
these settings. 

2. Use these settings to specify 
whether to send items to a folder 
other than the default folder.

3. Use this setting if you want to 
delete items in the folder that you 
are customizing.
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Choose your settings

Once you choose these settings, 
AutoArchive will just happen. That’s 
what makes it so easy. 

AutoArchive tab of the 
Properties dialog box 
for a folder

Still, do remember to perform 
periodic tune-ups. As you add or 
remove folders, you’ll want to adjust 
your custom AutoArchive settings to 
match. 
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Choose your settings

You may also want to adjust your 
settings if you get more (or less) 
mail for a while, join newsgroups, or 
otherwise change the rate of activity 
in the Inbox.

AutoArchive tab of the 
Properties dialog box 
for a folder

To test your AutoArchive settings, 
click AutoArchive in the Mailbox 
Cleanup dialog box (Tools menu). 
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Read archived messages

As the picture shows, you can do 
the following to read your archived 
messages: 

1. Click the plus sign next to 
Archive Folders in the Folder
List.

2. The list of your archived folders 
appears in Archive Folders. Click a 
subfolder to read the messages. 

Reading archived 
messages
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Or, don’t read archived messages

Maybe you don’t want to read your 
archived messages. In that case, 
you may not want to see Archive 
Folders in your Folder List, either. 

To stop seeing it, right-click Archive 
Folders as shown in the top image, 
and then click Close on the shortcut 
menu.

Hiding Archive Folders
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Or, don’t read archived messages

To make sure that Archive Folders
doesn’t reappear whenever 
AutoArchive runs, clear the Show 
archive folder in folder list check 
box in the AutoArchive dialog box. 

Hiding Archive Folders

You can do that when the dialog box 
next appears, or by opening that 
dialog box as described earlier.
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What AutoArchives, and when

Messages move to an archive folder 
when they achieve maturity.

"Maturity" doesn’t mean self-control 
or emotional balance here. It means 
how long a message sits around 
without your touching it. Maturity is 
based on the last modified date. 

When messages reach 
maturity, they move to 
an archive folder. 
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What AutoArchives, and when

These actions change the modified 
date (and time) of a message:

When messages reach 
maturity, they move to 
an archive folder. 

• Forwarding, replying, and replying 
to all

• Editing and saving

• Moving and copying
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Archive isn’t export

You may be familiar with the 
process of exporting data. Be 
warned: In Outlook, exporting isn’t 
like archiving. 

When you export messages, they 
stay in their original Mailbox  
location and are duplicated in a new 
Exported file. So exporting messages 
doubles their number and required 
space.

Exporting messages 
creates a copy in the 
exported file. 
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Archive isn’t export

Export when you want to copy 
messages—for example, if you want 
to use them in another program 
such as Microsoft Office Excel. 

Exporting messages 
creates a copy in the 
exported file. 

Archive when you want to move 
messages from one place to another 
in Outlook.
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Suggestions for practice

1. Review AutoArchive settings.

2. See where to customize settings for a folder. 

3. See where to run AutoArchive manually.

Online practice (requires Outlook 2003)

http://office.microsoft.com/training/training.aspx?AssetID=RP010265771033&CTT=6&Origin=RP010265761033
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Test 2, question 1

How do you read archived messages? (Pick one 
answer.)

1. Open Archive Folders in the Folder List by 
clicking the plus sign next to the folder. 

2. Click Archive on the File menu. 

3. Click AutoArchive in the Mailbox Cleanup dialog 
box. 
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Test 2, question 1: Answer

Open Archive Folders in the Folder List by clicking the 
plus sign next to the folder.
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Test 2, question 2

Outlook determines whether to archive  a 
message based on which property?  (Pick one 
answer.)

1. Creation date. 

2. Last modified date. 

3. The date the message was received. 
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Test 2, question 2: Answer

Last modified date. 
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Test 2, question 3

When you export messages from Outlook, what 
is the result? (Pick one answer.)

1. Messages are moved to Archive Folders. 

2. Messages are removed from the Mailbox and placed 
in the export file.  

3. Messages are copied to the export file, and they 
remain in the Mailbox. 
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Test 2, question 3: Answer

Messages are copied to the export file, and they remain in 
the Mailbox.



Lesson 3

Get personal with 
Personal Folders
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Get personal with Personal Folders

Filing e-mail in a personal folder 
gives you maximum control over 
how and where your stuff is stored. 

With personal folders, you set up 
the folders and move messages 
manually, exactly the way you want 
them.

Take the personal folders 
route. 
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Design your filing system

Does this sound like you?

With personal folders, 
you design the filing 
system. 

• You like an empty Inbox. 

• You like to file mail as soon as you 
finish reading it. 

• You like to group messages by 
project, topic, or other major 
category. 

• You enjoy devising filing systems. 
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Design your filing system

Does this sound like you?

With personal folders, 
you design the filing 
system. 

• You naturally think to update your 
filing system, for example when 
old projects are completed and 
new ones start.

• You create rules to move 
messages to specified locations. 

If so, you’ll really enjoy the control 
that personal folders give you.
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Design your filing system

With personal folders, you design 
the filing system.

With personal folders, 
you design the filing 
system. 

You can combine folders that are 
separate in your Mailbox, or you can 
split Mailbox folders, depending on 
your long-term needs for these filed 
messages. 
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Design your filing system

The picture illustrates how you 
name all the folders inside Personal 
Folders. 

With personal folders, 
you design the filing 
system. 

The Inbox contains a Jokes folder 
for all incoming jokes. After reading 
them, you could move the keeper 
jokes to Personal Folders, placing 
them in one of two folders: Old 
Jokes (Bad) or Old Jokes 
(Good).
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Create your filing system

To create your personal folders: 

1. On the File menu, click New.

2. Select Outlook Data File.

3. Select Microsoft Outlook 
Personal Folders File (.pst).

4. Now Personal Folders appears 
in the Folder List.

The Personal Folders
file in the Folder List
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Create your filing system

Once you create Personal Folders, 
it’s a good idea to create some 
folders inside it—you’re doing this 
because you want to get organized, 
right?

The Personal Folders
file in the Folder List

For example, a folder named 
Temporary can be a useful place to 
put messages you need to keep but 
don’t expect to keep for long. 
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Create your filing system

After you’ve got your filing system 
worked out, you can start moving 
messages by:

The Personal Folders
file in the Folder List

• Right-clicking them and then 
clicking Move (this is the only way 
to move a message while it’s open 
for viewing). 

• Dragging. 

• Creating rules to move them 
automatically. 
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Split Personal Folders

There are times when you might 
want to have two separate sets of 
personal folders. 

For example, you might create one 
top-level folder for messages about 
a specific project, while another top-
level folder stores non-business 
mail.Renaming these folders 

makes it easier to tell 
them apart. 
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Split Personal Folders

But whenever you add a new set of 
personal folders, the default top-
level folder name is Personal 
Folders.

Renaming these folders 
makes it easier to tell 
them apart. 

How original. It’s like naming your 
cat, “Cat.” And worse, it’s confusing.
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Split Personal Folders

The solution? Your common sense 
and creativity. As the picture shows:

Renaming these folders 
makes it easier to tell 
them apart. 

1. Take the hard-to-distinguish 
folders called Personal 
Folders…

2. …and change the folder names to 
something meaningful. Your 
personal folders get personal 
names. 
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What’s in a name?

To change the name of a folder from 
Personal Folders to something 
more personal, use the Outlook 
Data Files dialog box. 

To open it, click Data File 
Management in the Navigation 
Pane for Folder List.

Change a folder’s name 
by changing its settings.
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Suggestions for practice

1. Create the Personal Folders file. 

2. Create and name a folder inside Personal Folders. 

3. Move a message to the personal folder. 

(Continued on next slide.)
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Suggestions for practice, cont’d.

4. Create a second Personal Folders folder. 

5. Change the names of the Personal Folders folders. 

6. Create a password for personal folders

7. Remove the practice personal folders. 

Online practice (requires Outlook 2003)

http://office.microsoft.com/training/Training.aspx?AssetID=RP010265871033&CTT=6&Origin=RC010265551033
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Test 3, question 1

Why would you want to change the name 
Personal Folders to something else? (Pick one 
answer.)

1. Because you are using Personal Folders only for 
business e-mail. 

2. You have two or more Personal Folders folders. 

3. So that Outlook won’t overwrite your data. 
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Test 3, question 1: Answer

You have two or more Personal Folders folders. 

It helps you to tell them apart if they have different names.
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Test 3, question 2

Which of the following arrangements is possible 
with Personal Folders, but not with Archive 
Folders? (Pick one answer.)

1. You can rename Personal Folders in the Folder 
List. 

2. You can hide the file from view in the Navigation 
Pane. 

3. You could have more subfolders than you do in the 
Mailbox. 
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Test 3, question 2: Answer

You could have more subfolders than you do in the Mailbox.

You create the Personal Folders subfolders, so you can 
have as many as you like. The subfolders in Archive 
Folders, on the other hand, mirror the Mailbox.


